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M.Sc. – MATHEMATICS (2011 - 2014) 

COURSE STRUCTURE (CBCS)  

I  SEMESTER 

 

II SEMESTER 

COURSE H/W C COURSE H/W C 

Core 1 6 4 Core 5 6 4 

Core 2 6 4 Core 6 6 4 

Core 3 6 4 Core 7 6 4 

Core 4 6 4 Core Practical  6 3 

Elective - 1 ( Major ) 6 5 Elective - 2  (Non-Major)* 6 5 

                              TOTAL 30 21                         TOTAL 30 20 

 III SEMESTER IV SEMESTER 

Core 8 6 5 Core 12 6 5 

Core 9 6 5 Core 13 6 5 

Core 10 6 5 Core 14 6 5 

Core 11 6 5 Core 15 - Project 6 4 

Elective - 3  (Non Major)* 6 5 Elective - 4 ( Major ) 6 5 

                          TOTAL 30 25                       TOTAL 30 24 

DISTRIBUTION OF HOURS, CREDITS, NO. OF PAPERS   & MARKS  

               SUBJECT HOURS CREDITS 
NO. OF 

PAPERS 
MARKS 

Core + Practical  96 70 15 + 1 1600 

Elective ( Major / Non Major ) 24 20 2+2 400 

                            TOTAL 120 90 20 2000 

 

* For other major students 
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CBCS  SYLLABUS FOR  M. Sc. - MATHEMATICS  (2011 - 2014) 

SEM CO TITLE OF THE PAPER S.CODE H/W C 
MARKS 

I E T 

I 

C1 Groups, Rings & Fields 11PCMA11 6 4 25 75 100 

C2 Real  Analysis – I 11PCMA12 6 4 25 75 100 

C3 Java Programming 11PCMA13 6 4 25 75 100 

C4 Analytic Number Theory 11PCMA14 6 4 25 75 100 

E (M) 
A ) Differential Equations  OR 11PEMA1A 

6 5 25 75 100 
B ) Classical Mechanics 11PEMA1B 

II 

C5  Linear  Algebra 11PCMA21 6 4 25 75 100 

C6 Real Analysis – II 11PCMA22 6 4 25 75 100 

C7 Visual Basic 11PCMA23 6 4 25 75 100 

CP Core Practical  11PCMAP1 6 3 40 60 100 

E(NM)1 Choose from the NME List - 6 5 25 75 100 

III 

C8 Graph Theory  11PCMA31 6 5 25 75 100 

C9 Advanced Operations Research 11PCMA32 6 5 25 75 100 

C10 Complex Analysis 11PCMA33 6 5 25 75 100 

C11 Measure Theory and Integration 11PCMA34 6 5 25 75 100 

E(NM)2 Choose from the NME List - 6 5 25 75 100 

IV 

C12 Functional Analysis  11PCMA41 6 5 25 75 100 

C13 Topology 11PCMA42 6 5 25 75 100 

C14 Mathematical Statistics 11PCMA43 6 5 25 75 100 

C15 Project 11PPMA44 6 4 80 20 100 

E (M)  
A ) Differential Geometry  OR 11PEMA4A 

6 5 25 75 100 
B ) Coding Theory 11PEMA4B 

                                                                                   TOTAL 120 90 570 1430 2000 

 
* For other major students 

DEPT. OF MATHEMATICS (P.G.) 
CBCS  SYLLABUS -    M.Sc. – MATHEMATICS (2011 - 2014) 

Non-major Elective subject offered by PG Department of Mathematics to other major PG 
students 

SEM P TITLE OF THE PAPER S.CODE H/W C 
MARKS 

I E T 

II E(NM) 1 Quantitative Aptitude - I 11PEMA2N 6 5 25 75 100 

III E(NM) 2 Quantitative Aptitude - II 11PEMA3N 6 5 25 75 100 

                                                                                        TOTAL 120 90 520 1480 2000 
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CBCS SYLLABUS FOR M.Sc., MATHEMATICS 

(2011 – 2014) 

I SEMESTER 

Core 1                             GROUPS, RINGS & FIELDS                          11PCMA11 

Hrs / Week : 6           Hrs / Sem : 6x 15 = 90           Hrs / Unit : 18             Credit : 4 

 

OBJECTIVES: 

 To know the richness of the techniques of Mathematics by way of studying 

class equation, sylow’s theorem, direct products and finite abelian Groups. 

 To know that fields play a key role in algebra through a study of certain 

aspects of field theory which have impact on the theory of equations. 

 

UNIT I 

 A Counting principle – Another counting principle – Sylow Theorems  

 

UNIT II 

 Direct product – external, internal direct products - Finite Abelian groups. 

 

UNIT III  

 Euclidean rings – Particular Euclidean rings-Polynomial rings-Polynomial 

over the Rational Field. 

 

UNIT IV  

 Extension fields – Roots of Polynomial. 

 

UNIT V  

 More about roots - Elements of Galoi’s Theory – (Fundamental theorem of 

Galoi’s theory – statement only) 

 

TEXT BOOK: 

1. I.N. Herstein – Topics in Algebra – Wiley Eastern Limited, New Delhi.   

UNIT I: Section 2.5, 2.11, 2.12. 

UNIT II: Section 2.13, 2.14. 

UNIT III: Section 3.7 to 3.10. 

UNIT IV: Section 5.1, 5.3. 

UNIT V: Section 5.5, 5.6. 
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I SEMESTER 

Core 2                                         REAL ANALYSIS I                                      11PCMA12 

Hrs / Week : 6                   Hrs / Sem : 6 x 15 = 90            Hrs / Unit :18          Credit : 4 

 

OBJECTIVES: 

 To provide deep understanding of the Metric concepts. 

 To learn more about continuity and differentiations. 

 

UNIT I  

Basic topology: Finite, countable and uncountable sets -- metric spaces – 

compact sets - perfect sets – connected sets. 

 

UNIT II 

 Numerical sequences and series: Convergent sequences – Subsequences – 

Cauchy sequences – Upper and lower limits – some special sequences.  

 

UNIT III 

  Series – Series of Nonnegative terms – the number e-the root and ratio test. .  

Power series – summation by parts – absolute convergence addition and 

multiplication of series – Rearrangement.  

 

UNIT IV 

Continuity 

 

UNIT V  

Differentiation  

 

TEXT BOOK: 

       Rudin – ―Principles of Mathematical Analysis‖ – 3
rd

 Edition, Tata and McGraw 

Hill 

  

  Unit I  : chapter 2(full) 

  Unit II : chapter 3(section 3.1-3.20) 

      Unit III   : chapter 3(section 3.21-3.55) 

      Unit IV :  chapter 4(full) 

   Unit V  : chapter 5(full) 
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I SEMESTER 

Core 3                                JAVA PROGRAMMING                              11PCMA13 

Hrs / Week : 6              Hrs / Sem : 6 x 15 = 90          Hrs / Unit : 18          Credit : 4 

 

OBJECTIVES: 

 To have a deep knowledge of JAVA Language. 

 To study Classes, Objects and Methods. 

 To Learn more about inheritance, Packages and Interfaces. 

 To Motivate the students to implement problems in JAVA. 

 

UNIT I 

          Overview of Java Language – Data types, variables, arrays – Operators, control 

statements, decision making, branching and looping.  

 

UNIT II 

           Classes, Objects and methods  

 

UNIT III  

 Inheritance – packages and interfaces  

 

UNIT IV  

 Exception handling – multi threaded  

 

UNIT V  

 Numerical solutions of ODE- Euler’s method and R-K methods. 

 

TEXT BOOKS: 

1. Patrick naughton, Herbert Schildt-JAVA – 2, The complete reference (3
rd

 

edition), Tata McGraw Hill 1999. 

2. Herbert Schildt-JAVA – 2, The complete reference (4
th

 edition), Tata 

McGraw Hill 2001.  

3. G.F. Simmons- Differential equations. 

Sections:  72, 74, 75. 
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I SEMESTER 

Core 4                                ANALYTIC NUMBER THEORY                      11PCMA14 

Hrs / Week : 6               Hrs / Sem : 6 x 15 = 90             Hrs / Unit : 18          Credit : 4 

 

OBJECTIVES: 

 To have a deep knowledge in Analytic Number theory. 

UNIT I   

            The Fundamental Theorem of Arithmetic: Introduction – Divisibility – 

Greatest common divisor - Prime numbers - Fundamental theorem of arithmetic-The 

series of reciprocals of the primes – The Euclidean algorithm – The greatest common 

divisor of more than two numbers. 

UNIT II 

             Arithmetical Functions and Dirichlet Multiplication: Introduction – The 

Mobius function μ(n) – The Euler totient function φ(n) – A  relation connecting φ and 

μ –A product formula for φ(n) – The Dirichlet product of arithmetical functions – 

Dirichlet inverses and the Mobius inversion formula – – 

Multiplicative functions – Multiplicative functions and Dirichlet multiplication – The 

inverse of a completely multiplicative functions – Liouville’s function λ(n) – The 

divisor functions σα(n) – Generalized convolutions. 

UNIT III  
    Averages of Arithmetical Functions: Introduction – The big oh notation. 

Asymptotic equality of functions – Euler’s summation formula - Some Elementary 

asymptotic formulas – The average order of d(n) – The average order of the divisor 

functions σα(n) The average order of φ(n) – An application to the distribution of 

lattice points visible from the origin – The average order of μ(n) and of Λ(n). 

UNIT IV   

         Some Elementary Theorems on the Distribution of Prime Numbers: 

Introduction  - Chebyshev’s  functions ψ(x) and ύ(x) – Relations connecting ύ(x) and 

π(x) – Some equivalent forms of the prime number theorem – Inequalities for  π(n) 

and pn – Shapiro’s Tauberian theorem. 

UNIT V  

 Congruences: Definition and basic properties of congruences – Residue 

classes and complete residue systems – Linear congruences – Reduced residue 

systems and the Euler-Fermat theorem – Polynomial congruences modulo 

p.Lagrange’s theorem – Applications of Lagrange’s theorem. 

 

TEXT BOOKS: 

Tom M.Apostol - Introduction to analytical number theory. 

UNIT I:    Chapter 1 (1.1 to 1.8). 

UNIT II:  Chapter 2 (2.1 to 2.14). 

            UNIT III: Chapter 3 (3.1 to 3.9). 

UNIT IV: Chapter 4 (4.1 to 4.6). 

UNIT V:  Chapter 5 (5.1 to 5.6). 
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I SEMESTER 

E1 A(M)                            DIFFERENTIAL EQUATIONS                   11PEMA1A 

Hrs / Week : 6              Hrs / Sem : 6 x 15 = 90         Hrs / Unit : 18           Credit : 5 

 

OBJECTIVES: 

 To discuss several methods for finding series solutions to differential 

equations.  

UNIT I 

 Power series solutions – a review of power series – series solutions of first 

order equations. 

UNIT II  

 Second order linear equations - Ordinary points – Regular singular points. 

UNIT III 

  Gauss Hyper Geometric equation – Point at infinity – Hermite polynomial. 

UNIT IV 

Legendre  Polynomials - Bessel functions. 

UNIT V 

 Properties of Bessel functions – Linear systems – homogeneous linear systems 

with constant coefficients. 

 

TEXT BOOK: 

G.F. Simmons - Differential equation with application and historical notes –  

    Tata Mc Graw Hill Publication--Edition -2.  

    UNIT I     : Chapter 5 (26, 30). 

    UNIT II   : Chapter 5 (28, 29, 30). 

    UNIT III : Chapter 5 (31, 32). 

    UNIT IV  : Chapter 5 (Appendix B) and Chapter 8 (44). 

    UNIT V   :  Chapter 8 (46, 47). 
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                                                                   I SEMESTER 

E 1 B(M)                              CLASSICAL MECHANICS                                 11PEMA1B 

Hrs / Week : 6                  Hrs / Sem : 6 x 15 = 90               Hrs / Unit : 18          Credit : 5 

 

OBJECTIVES: 

 To learn more about of the mechanics of a partical, Lagranges equations, 

Hamiltons equations. Predicate calculus. 

 To learn about Central force problems, Kepler’s problem. 

UNIT I  

           Mechanics of particle - Mechanics of a system of particles. 

UNIT II 

           D’Alembert’s principle and Lagrange’s Equations - velocity dependent 

Potentials and the dissipation functions - simple applications of Lagrangion 

formulation. 

UNIT III 

           Hamilton’s Principles - some techniques of the calculus of variations - 

Derivation of Lagrange’s equations from Hamilton’s principle - Extension of 

Hamilton’s principle to non-holomonic systems - Advantage of a variational principle 

formulation – conservation theorems and symmetry properties.    

UNIT IV 

 The two body central force problem - reduction to the equivalent one body 

problem - The equivalent motions and first integrals - The equivalent one dimensional 

problem and classification equation for the orbit and integrable power law potentials. 

UNIT V 

           Condition for closed orbits - The Kepler problem - Inverse Square law of force 

-The motion in time in the Kepler problem - The Laplace-Runge-Lenz vector. 

 

TEXT BOOK: 

H. Goldstein- Classical Mechanics-Second Edition.Addison Wesley 

Chapters: 1, 2, and 3(Except Sections 3.10 and 3.11) 
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II SEMESTER 

Core 5                                      LINEAR   ALGEBRA                             11PCMA 21 

Hrs / Week : 6              Hrs / Sem : 6 x 15 =90          Hrs / Unit :18            Credit : 4 

 

OBJECTIVES: 

 

 To study the basic concepts of linear dependence, basis and Homomorphisms 

of vector spaces. 

 To understand an extremely rich structure called algebra of linear 

transformations and the two canonical forms: triangular form and nilpotent 

transformations. 

 To learn about Trace and Transpose, determinants and Real Quadratic forms. 

 

UNIT I 

           Vector Space – Linear independence and bases – Dual Space. 

UNIT II 

           Inner product spaces and modules. 

UNIT III 

           The algebra of linear transformations – Characteristic roots – Matrices. 

UNIT IV 

           Triangular form--Nilpotent form –Trace and Transpose. 

UNIT V 

            Determinants – Hermitian, Unitary and Normal Transformation—Real 

Quadratic forms. 

 

TEXT BOOK: 

N.  Herstein: Topics in Algebra (2
nd

 edition).   

UNIT I   :  Section 4.1 to 4.3 

UNIT II  : Section 4.4 to 4.5 

UNIT III : Section 6.1 to 6.3 

UNIT IV : Section 6.4, 6.5, 6.8 

UNIT V:   Section 6.9, 6.10, 6.11 
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II SEMESTER 

Core 6                                              REAL ANALYSIS II                                 11PCMA 22 

Hrs / Week : 6                    Hrs / Sem : 6x 15 =90              Hrs / Unit : 18           Credit : 4 

 

OBJECTIVES: 

 To learn about Riemann integration, Sequence and series of functions. 

Equicontinuous families of functions, Functions of several variables. 

 To learn about the LP
 spaces. 

 

UNIT I 

           Riemann – Stieltjes Integral – Definition – Properties – Integration and 

differentiation – Integration of vector valued functions – Rectifiable Curves. 

 

UNIT II 

           Sequences and series of functions- Discussion of main problem - Uniform 

convergence – Uniform convergence and continuity – Uniform convergence and 

Integration. 

 

UNIT III        

 Uniform convergence and Differentiation - Equicontinuous Families of 

functions - The stone Weierstrass theorem (Generalization of stone’s Weierstrass 

theorem statement only). 

 

UNIT IV  

 Functions of Several variables: Differentiation - The contraction principle - the 

inverse function theorem - The implicit function theorem. 

 

UNIT V 

  The L
p
 spaces: Holder and Minkowski’s inequalities – Convergence and 

completeness – Bounded linear functional on the L
p
 spaces. 

 

TEXT BOOKS: 

1. Walter Rudin – Principles of Mathematical Analysis, (3
rd

 Edition), Mc Graw 

Hill International Edition.  Chapter 6, 7 and 9 (Sections 9.10 to 9.29) 

2. H.L. Royden-Real Analysis (2
nd

 Edition). The Macmillan company, Inc,                

      Newyork collier Mac Millan Publishers, London. Chapter 6 (Full). 
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II SEMESTER 

Core 7                                            VISUAL BASIC                                  11PCMA23 

Hrs / Week : 6           Hrs / Sem : 6 x 15 = 90             Hrs / Unit : 18          Credit : 4 

 

OBJECTIVES: 

 To have a deep knowledge of Visual Basic. 

 

 UNIT I 

          Introduction : The initial VB Screen – The single Document Interface 

Environment – The Help system – Toolbars – The Toolbox and custom controls and 

Components – using the File menu – Editing – Using the View menu – Using the 

Project menu – the Format menu – the Run and Debug menu – Using the Tools menu 

– Using the Add – Ins menu – using the Window menu  

 

UNIT II 

           Customizing a Form and Writing simple Programs: Starting a New Project – 

the Properties Window – Common Form Properties – Making a form responsive – 

Printing a Visual representation of a Form – Types – Saving your work – Creating 

Stand – alone Windows Programs  

           First steps in building the User Interface: The Toolbox – the Control Name 

Property – Simple Event Procedures for comma Buttons – Access Keys – Image 

controls – Text Boxes – Labels – Navigating between controls – Message Boxes – the 

Grid – the Display in VB.  

 

UNIT III  

            First steps in Programming: The code Window – VB’S editing tools – 

statements in VB – Variables – setting properties with code – Data types – more on 

strings – more on numbers – Constants – Input Boxes.  

 Displaying Information: Displaying information on a Form – the Format 

function – Picture boxes – Rich Text boxes – the Printer Object.  

 

UNIT IV 

            Controlling Program Flow: Determine Loops – Indeterminate Loops – making 

decisions – Select Case – Nested If – Then’s – the Goto.  
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 Built – in Functions : String functions – the Like function and Fuzzy searching 

– the Rnd function – Bit – Twiddling functions – Numeric functions – Date and Time 

functions – Advanced Uses of Procedures and Functions – Object Browser 

 Organizing Information Via Code : Lists – One-Dimensional Arrays – Arrays 

with more than one dimension – using lists and arrays with Functions and Procedures 

– the New Array – based String handling functions – Sorting and Searching – Records 

– the with Statement – Enums.  

 

UNIT V 

 Organizing Information via controls: Control Arrays – List and Combo Boxes 

– the Flex Grid Control.  

 Building larger projects : Projects with Multiple Forms – Code Modules – 

Global Procedures and Global variables – the Do Events Function and Sub Main – 

Sub Main   

 Finishing the Interface: Option Buttons – Common Dialog Boxes – the 

Microsoft Windows Common Controls 6.0 – Menus – MDI Forms.  

 

 

TEXT BOOK: 

1. Gary Cornell – Visual Basic 6 form the Ground UP –Tata McGraw and 

Hill  Edition 2002 (11
th

 Reprint) 

      Chapters: 2 -12, 14. 

 

REFERENCE BOOKS: 

1. Steve Brown-, Visual Basic 6 in Record time, BRB publications. 

2. Deital & Deital-Visual Basic 6.0. 

3. N. Krishnan (Scitech)-Visual Basic 6.0 in 30 days.  
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I& II SEMESTERS 

CORE PRACTICAL               JAVA AND VISUAL BASIC                       11PCMAP1 

Hrs/Week : 6                                Hrs / Sem : 6 x 15 = 90                            Credit : 3 

                          

         JAVA PROGRAMMING PRACTICAL 

 

1. Simple JAVA program  

2. Programs using 1 – D, 2 – D Rays 

3. Programs using control statements  

4. Programs using classes and objects  

5. Programs using overloading  

6. Programs using riding and inheritance  

7. Programs using interface  

8. Programs using package  

9. Programs using threading concept  

10. Programs suing exception handle 

11. Programs on string manipulations. 

12. Programs on Numerical methods. 

   VISUAL BASIC PRACTICAL 

1. Arithmetic Calculator  

2. Design a clock 

3. Menu Creation – with simple file and edit options 

4. Designing a color mixer using basic colors  

5. Create a file open dialogue box to load a picture 

6. Create an application to format the text inside the text box  

7. Create an application to do the matrix additions, multiplication  

8. Viewing records using data base controls 

9. Adding records to database using database controls  

10. Accessing Database files using ODBC 

11. Display the information in the report form  

12. Create an application to move the elements from list to list and add new items  

13. Picture Animation  

14. Rolling Dice Simulator  

15. Objective type Questionnaire 
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III SEMESTER 

Core 8                                        GRAPH THEORY                                 11PCMA 31 

Hrs / Week : 6            Hrs / Sem : 6 x 15 = 90             Hrs / Unit : 18         Credit : 5 

     

OBJECTIVES: 

 To provide an indepth knowledge of graph theoretical concepts. 

 To explore the various applications of graph theory. 

 To motivate the students to do research in discrete and applied mathematics. 

 

UNIT I 

           Trees: Bridges - Trees. Connectivity: Cut vertices - Blocks – Connectivity. 

UNIT II 

            Traversability: Eulerian graphs–Hamiltonian graphs. Digraphs: Strong 

Digraphs. 

UNIT III  

            Matchings and Factorizations: Matchings – Factorization.   

UNIT IV  

 Planarity: Planar graphs –Embedding Graphs on surfaces. 

            Coloring: Vertex coloring  

UNIT V  

            Edge coloring –The Heawood Map colouring theorem. 

            Ramsey Numbers: The Ramsey number of graphs.    

            Distance: The centre of a graph. 

 

 TEXT BOOK: 
Gary Chartrand and Ping Zhang-Introduction to Graph Theory   

             Edition 2006. Tata McGraw-Hill Publishing Company Limited, New Delhi. 

              UNIT I:    Chapter 4(4.1, 4.2), Chapter 5(5.1, 5.2, 5.3). 

              UNIT II:  Chapter 6(6.1, 6.2), Chapter 7(7.1). 

              UNIT III: Chapter 8(8.1, 8.2). 

              UNIT IV: Chapter 9(9.1, 9.2), Chapter 10 (10.2). 

              UNITV:    Chapter 10 (10.3,10.4), Chapter 11(11.1), Chapter 12 (12.1).  

 

REFERENCE BOOKS: 

1. J. Bondy & U.S.R. Murty -Introduction to Graph theory. 

2. D.West-Introduction to Graph Theory.  
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 III SEMESTER 

Core 9                  ADVANCED   OPERATIONS  RESEARCH            11PCMA32 

Hrs / Week : 6          Hrs / Sem : 6 x 15 = 90          Hrs / Unit : 18              Credit : 5 

 

OBJECTIVES: 

 To understand the concept of Linear and Non-Linear Programming. 

 To understand the concept of dynamic programming and Decision Theory 

 To learn about inventory Models. 

 

UNIT I.  

 Game theory- Solutions of m x 2 and 2 x n games- Algebraic method, iterative 

method, simplex method- fundamental theorem of game theory. 

 

UNIT II 

 Non-linear programming – Formulation Graphical solution – constraint 

optimization with equality constraint - constraint optimization with inequality 

constraint.  

 

UNIT III  

 Dynamic programming – recursive equation approach – solution of LPP by 

D.P – Optimal  subdivision problem, Stage coach problem, investment problem 

,employment  smoothening problem. 

 

UNIT IV  

 Queuing theory. Distribution of arrivals (pure –birth process) Distribution of 

inter arrival times. Distribution of departures (pure death process) single channel 

finite Q and infinite Q multi channel finite Q and infinite Q, machine repair model.  

 

UNIT V 

 Decision Theory. Decision making process – Decision under uncertainty – Decision 

under risk. Decision tree analysis-Inventory models (deterministic only)  

 

REFERENCE BOOK: 

1. Kanti Swarup & Others. Operations Research. 

2. Mangaladoss- Operation Research.  

3. Visit: www. math_materials.com
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III SEMESTER 

Core 10                                   COMPLEX ANALYSIS                            11PCMA33 

Hrs / Week : 6               Hrs / Sem : 6 x 15 = 90           Hrs / Unit : 18        Credit : 5 

     

OBJECTIVES: 

  

 To develop the basic concepts of complex analysis. 

 

UNIT I 

          Complex function: Introduction to the concept of analytic function – elementary 

theory of power series  

 

UNIT II 

          Conformality: Arcs and closed curves – Analytic functions in regions - 

Conformal mapping - the Linear Group - the cross ratio - Symmetry. 

 

UNIT III 

          Complex integration: fundamental theorems – Cauchy’s integral formulae  

 

UNIT IV  

 Local properties of Analytic function – the Calculus of Residues  

 

UNIT V  

 Harmonic functions – Power series expansion  

 

TEXT BOOKS: 

         ‘Ahlfors’ Complex analysis – third edition Tata Mc Graw Hill Ltd sections 

 

UNIT I:    Chapter 2 (1.1 to 1.4, 2.1 to 2.5). 

UNIT II:   Chapter 3 (2.1 to 2.4, 3.1 to 3.3). 

UNIT III: Chapter 4 (1.1 to 1.5, 2.1 to 2.3). 

UNIT IV: Chapter 4 (3.1 to 3.3, 5.1 to 5.3). 

UNIT V:   Chapter 4 (6.1 to 6.4), Chapter 5 (1.1 to 1.3). 
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                                                                  III SEMESTER 

Core 11 MEASURE THEORY AND INTEGRATION 11PCMA 34 

Hrs / Week : 6 Hrs / Sem : 6 x 15 = 90     Hrs / Unit : 18 Credit : 5 

 

 OBJECTIVES: 

 

 To Introduce the Lebesgue Measure and Lebesague Integrals, Measure and 

Integration.  

 

UNIT I 

          Lebesgue Measure: Introduction - Outer Measure - Measurable Sets and 

Lebesgue Measure - Non Measurable set - Measurable Functions - LittleWood’s three 

principles. 

UNIT II 

           The Lebesgue Integral: Riemann Integral - The Lebesgue Integral of a 

bounded function over a set of finite measure - The Integral of a non negative 

function - The general Lebesgue Integral - Convergence in Measure.  

UNIT III 

         Differentiation and Integration: Differentiation of monotone functions - 

Functions of bounded variations - Differentiation of an integral - Absolute continuity. 

UNIT IV  

            Measure and Integration: Measure Spaces - Measurable functions-Integrations 

-General convergence Theorems - Signed Measures - The Radon Nikodym Theorem. 

UNIT V 

           Measure and Outer Measure: Outer Measure and Measurability - The 

Extension Theorem - The Lebesgue-Stieltjes integral - Product Measures - Integral 

Operators. 

 

TEXT BOOKS: 

            H.L.Roydon-Real Analysis, Collier Macmillan International Edition-3
rd

 

Edition 

Unit I:      Chapter 3(1 to 6) 

Unit II:    Chapter 4(1 to 5) 

Unit III:   Chapter 5(1 to 4) 

Unit IV:   Chapter 11(1 to 6) 

Unit V:    Chapter 12(1 to 5) 
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                                                            IV SEMESTER 

Core 12 FUNCTIONAL ANALYSIS  11PCMA 41 

Hrs / Week : 6 Hrs / Sem : 6 x 15 = 90    Hrs / Unit : 18 Credit : 5 

 

OBJECTIVES: 

 To introduce the study of   functions and Hahn- Banach theorem and its 

applications. 

 To introduce Hilbert spaces, conjugate spaces, adjoint, self adjoint, normal and 

unitary operators.  

 To introduce finite dimensional  spectural theory. 

     

UNIT I 

          Banach spaces: definition and examples – continuous linear transformation – 

Hahn – Banach theorem.  

 

UNIT II 

   The natural embedding – open mapping theorem – Conjugate of an operator   

 

UNIT III  

 Hilbert space – definition and properties – orthogonal complements – 

orthogonal sets – conjugate space  

 

UNIT IV  

 Adjoint of an operator – self adjoint operator – Normal and Unitary operators 

– projections.  

 

UNIT V  

 Spectral theory – spectrum of an operator – spectral theorem  

 

TEXT BOOK: 

            G.F.Simmons – Introduction of Topology and Modern Analysis. 

UNIT I:     Chapter 9 (46 to 48). 

UNIT II:   Chapter 9 (49 to 51). 

UNIT III:  Chapter 10 (52 to 55). 

UNIT IV:  Chapter 10 (56 to 59). 

UNIT V:    Chapter 11(60 to 62).  
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                                                                  IV SEMESTER 

Core 13 TOPOLOGY  11PCMA 42 

Hrs / Week : 6 Hrs / Sem : 6 x 15 = 90     Hrs / Unit : 18 Credit : 5 

   

 OBJECTIVES: 

 To introduce basic concepts of Topology. 

 To introduce product Topology and quotient Topology. 

 To study the countability axioms and urysohn metrization theorem. 

 

UNIT I 

           Topological spaces - Basic for a Topology - Order Topology - The product 

Topology on X х Y – The Subspace Topology - closed sets and limit points 

 

UNIT II 

           Continuous functions – Product Topology - Quotient Topology.  

 

UNIT III  

 Connected spaces, components and local connectedness - compact spaces  

 

UNIT IV  

 Local   compactness - Countability axioms - Separation axioms. 

 

UNIT V  

 Normal Spaces – Urysohn lemma - Urysohn metrization theorem. 

 

TEXT BOOKS: 

 

         J.R. Munkrus- Topology. [2
nd  

Edition, Pearson education agency- Delhi 

(2002)] 

 

               UNIT I:      Chapter 2 (12 to 17). 

               UNIT II:    Chapter 2(18, 19, 22). 

               UNIT III:   Chapter 3 (23, 25, 26). 

               UNIT IV:   Chapter 3 (29), Chapter 4 (30, 31). 

               UNIT V:     Chapter 4 (32, 33, 34). 
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IV SEMESTER 

Core 14 MATHEMATICAL STATISTICS 11PCMA 43 

Hrs / Week : 6 Hrs / Sem : 6 x 15 = 90     Hrs / Unit : 18 Credit : 5 

    

 OBJECTIVES: 

 To learn the basic concepts of Mathematical Statistics. 

 

UNIT I 

             Conditional Probability and Stochastic Independence. 

 

UNIT II 

           Some Special Distributions. 

 

UNIT III  

           Sampling Theory - Transformation of variables - t and f Distributions. 

 

UNIT IV 

           Change of variable Technique - The MGF-Distributions of x and ns²/σ² -

Expectations of functions of random variables. 

 

UNIT V 

 Limiting Distributions. 

 

TEXT BOOK: 

1. Robert V.Hogg and Allen T.Craig-Introduction to Mathematical 

Statistics-Pearson Education Asia, Chapters 2, 3, 4 and 5(except section 4.10) 

 

 

 

 

 

 

 

 

 

 

 

 

424



 

IV SEMESTER 

Core 15 PROJECT  11PCMA 44 

Hrs / Week : 6 Hrs / Sem : 6 x 15 = 90     Credit : 4 

     

 

OBJECTIVE:  

Every PG student is required to prepare the project subject related – based on 

the 

Guidelines of his project guide.  

 

GUIDELINES: 

The following are the guidelines to be adhered to  

1. The project should be an individual one  

2. The language for the project is English 

3. The Minimum number of page should be 60 

4. Project observations, suggestions and conclusion shall form an 

inevitable part of the project.  

5. Marks for the project report will be 100 divided as 80% for project and 

20% for viva-voce.  

425



 

 

IV SEMESTER 

E 4 A(M) DIFFERENTIAL GEOMETRY 11PEMA 4A 

Hrs / Week : 6 Hrs / Sem : 6 x 15 = 90       Hrs / Unit :18 Credit : 5 

 

OBJECTIVES: 

 

 To learn about the basic concepts of Differential Geometry. 

 

 

 

UNIT I 

           Space curves: definitions – arc length – tangents, normal and binormal – 

curvature and torsion – tangent surfaces – involutes and evolutes.  

 

UNIT II 

           Intrinsic equations – fundamental existence theorem for space curves – 

Helices surfaces: definition of Surface – Surfaces of revolution – Helicoids – Metric.  

 

UNIT III  

 Direction of coefficients – Families of curves – Isometric correspondence – 

intrinsic properties – geodesics.  

 

UNIT IV  

 Canonical geodesic equations – normal property of geodesic – geodesic 

curvature – Gauss – Bonnet theorem – Gaussian Curvature.  

 

UNIT V  

 The second fundamental form – principal curvature – lines of curvature – 

Developables associated with space curves, - minimal surface.  

 

TEXT BOOKS: 

          T.J. Wilmore – An introduction of Differential Geometry (1
st
 edition, Oxford) 

Unit I : 1.1 to 1.5, 1.7 

Unit II : 1.8, 1.9, 2.1 to 2.5 

Unit III: 2.6 to 2.10 

Unit IV: 2.11, 2.12, 2.15, 2.16, 2.17 

Unit V : 3.1 to 3.5, 3.7 
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IV SEMESTER 

E 4 B(M) CODING THEORY 11PEMA4B 

Hrs / Week : 6 Hrs / Sem : 6 x 15 = 90 Hrs / Unit : 18 Credit : 5 

 

OBJECTIVES: 

 To learn about the Overview in coding theory. 

 

UNIT I 

 Error detection and correction - Minimum distance decoding  

 

UNIT II 

 Families of codes  

 

UNIT III  

Linear codes and their duals - Weight distributions  

 

UNIT IV  

 Hamming and Golay codes - Reed Muller Codes   

 

UNIT V  

 Cyclic codes -  More on cyclic codes  

 

TEXT BOOK: 

Steven, Springer-Coding and Information Theory – Verlag 1992.  

 Chapter 4 : Sections 4.1,4.2.4.3 

             Chapter 5 : Sections 5.1,5.2, 

             Chapter 6 : Sections 6.1, 6.2. 

             Chapter 7 : Sections 7.4 and 7.5. 
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